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ВВЕДЕНИЕ 

ДВИЖЕНИЕ ЖИДКОСТИ В КАНАЛЕ ПЕРЕМЕННОГО СЕЧЕНИЯ 
 

Цель работы - экспериментальное подтверждение закона сохранения и 
превращения механической энергии для потока несжимаемой жидкости. При 
этом измеряются давление в потоке и давление торможения по длине канала 
переменного сечения. Рассчитываются объёмный расход жидкости, скорость 
потока жидкости в характерных сечениях трубы. Устанавливаются 
закономерности изменения вдоль потока несжимаемой жидкости давления и 
давления торможения, скорости движения и гидравлических потерь. 

 
 
 
 
 
 
 
 

СОЗДАНИЕ РАСЧЕТНОЙ МОДЕЛИ  

На первом этапе построения модели будут построены точки контура 

канала (таблица 1.1). Затем на их базе будут получены границы расчетной 

области с помощью отрезков, которые станут основой для создания 

поверхностей двухмерной расчетной модели.  

1.1 Построение базовых точек 

Меню построения точек по координатам (рисунок 1.1) вызывается в 

главном меню с помощью команды: 

Geometry 
 → Vertex 

 → 

Create 
vertex 

 (Геометрия) (Точка) (Создание 
точки) 

В появившемся меню в поле Global (в глобальной системе координат) 

следует ввести координату требуемой точки, например (1000; 0; 0). 

Подтверждается построение точки нажатием кнопки «Apply». Аналогичным 

образом следует ввести все точки профиля канала из таблицы 1.1. 

Таблица 1.1 – Координаты точек сечения трубы. 
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Х 0 0 0 14 330 770 330 770 835 835 1000 1000 
У  0 14 265 265 -7 -7 21 21 0 14 0 14 

 

В случае совершения ошибки действие можно отменить с помощью 

кнопки  («отмена»). Увидеть все построенные точки можно с помощью 

кнопки  («вписать в экран»). 

Результат построения изображен на рисунке 1.2. 

 
Рисунок 1.1 - Меню построения точек по координатам 

 

 
Рисунок 1.2 - Построенные базовые контура 

 

1.2 Построение контура канала 

Контур канала образован двенадцатью отрезками. 

 



Для построения нужно вызвать соответствующее меню (рисунок 1.3) 

командой: 

Geometry 
 → Edge 

 → 

Create 
edge 

 (Геометрия) (Линия) (Создание 
линии) 

 
Рисунок 1.3 – Меню построения отрезков 

 

Для построения контура канала необходимо с помощью мыши и 

нажатой клавиши Shift выбрать соответствующие точки в порядке 

следования. Для принятия действия нужно нажать кнопку «Apply». Результат 

действия показан на рис. 1.4.  

 
Рисунок 1.4 - Результат построения контура 
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1.3 Построение поверхности 

Основой для построения конечно-элементной сетки двухмерной модели 

является поверхность. Она строится с помощью меню построения 

поверхности (рисунок 1.5):  

Geometry 

 → 
Face 

 → 
Form face 

 (Геометрия) (Поверхность) (Создание 
поверхности) 

В появившемся меню необходимо поставить курсор в окно Edges и с 

помощью мыши выбирать линии, образующие замкнутый контур расчетной 

области. Для построения поверхности следует нажать кнопку «Apply». В ре-

зультате линии контура модели поменяют цвет. 

 

 
Рисунок 1.5 - Меню построения поверхности по линиям 

 

1.4 Указание граничных поверхностей. 

В программе Gambit осуществляется предварительное указание линий и 

поверхностей расчетной области, к которым будут приложены граничные 

условия. Численные значения граничных условий задаются в программе 

Fluent. Поверхности, которые не будут указаны как граничные, по 

умолчанию считаются стенками и к ним применяется соответствующее 

граничное условие. Указанный в программе Gambit тип граничного условия в 

случае ошибок или изменения стратегии решения можно поменять во Fluent. 

Для выхода в меню задания граничных условий (рисунок 1.6) необходимо 

нажать следующие кнопки в главном меню: 
 



Zones 

 → 

Specify 
Boundary Types 

 (зоны) (Задать тип 
граничных 
условий) 

Для определения входной границы в нем необходимо произвести 

следующие действия: 

− В поле Action необходимо нажать кнопку Add. Это действие укажет на 

то, что будет задана новая граничная поверхность. 

− В графе Name можно задать наименование граничного условия 

латинскими буквами. Если поле оставить пустым, то имя будет 

назначено автоматически в соответствии с типом граничного условия. 

− Нажать кнопки Show labels и Show colors. В результате в окне 

построения созданные граничные условия будут подписываться и 

выделяться цветом. 

− Щелкнуть мышью по кнопке Type. В результате откроется доступ к 

списку доступных граничных условий. Содержание списка зависит от 

расчетной программы, которая была выбрана в начале построения 

модели. Для задания входного граничного условия нужно выбрать 

pressure inlet (давление на входе). 

− Поскольку решаемая задача двухмерная, то граничные условия будут 

задаваться на линиях. Для того, чтобы определить это, необходимо 

щелкнуть мышью на кнопке в области Entity и в появившемся списке 

выбрать Edge. 

− Поставить курсор в поле напротив кнопки Edge и с помощью мыши 

выбрать входную границу расчетной области (рисунок 1.6). Если 

произошла ошибка, то удалить линию из списка можно, нажав кнопку 

Remove. 

− Выбранные настройки границы подтверждаются нажатием кнопки 

«Apply».  
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Рисунок 1.6 - Меню задания граничных условий 

 
В результате выполнения команды в списке в верхней части меню 

появится название созданного граничного условия, а в области построения 

оно будет выделено цветом и высветится его имя.  

Аналогично на выходной границе расчетной области устанавливается 

граничное условие pressure outlet (давление на выходе). 

Результат построения граничных условий показан на рисунке 1.7. На 

остальных ограничивающих модель поверхностях, которые не были 

отмечены как граничные, по умолчанию будет установлено граничное 

условие стенки (Wall). 

 



 
Рисунок 1.7 - Результат задания граничных условий 

 

1.5 Построение конечно-элементной сетки 

В сеткогенераторе Gambit есть возможность разбивать расчетную 

область, как на четырехугольные, так и на треугольные элементы. Конечно-

элементная сетка может быть структурированной или неструктурированной 

(сетка на базе треугольных элементов только неструктурированная). 

Структурированная сетка позволяет получать более точные решения, однако 

она сложнее в построении, особенно для моделей со сложной 

пространственной формой. Время построения такой сетки может достигать 

80% времени работы над задачей.  

Решение рассматриваемой задачи течения газа в канале целесообразно 

провести на неструктурированной конечно-элементной сетке, поскольку 

такое разбиение не составит большого труда и не займет много времени.  

 
Разбиение поверхности осуществляется с помощью команды: 

Mesh 
 → 

Face 
 → 

Mesh face 
 (Сетка) (Поверхность) (разбить 

поверхность) 
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В результате появится меню, изображенное на рисунке 1.8.  

В нем следует провести следующие манипуляции: 

− В поле Face надо выбрать поверхности, которые будут разбиваться. 

− В поле Elements выбирается тип конечного элемента Quad (че-

тырехугольный), Tri (треугольный) или Quad/Tri (смешанный). Для 

данной задачи выбирается Tri (треугольный). 

− В поле Type выбирается схема, по которой производится 

разбиение. Схемы Submap, Map используются для 

структурированной сетки, схема Pave – для неструктурированной. 

При решении рассматриваемой задачи следует выбрать схему Pave.  

− В поле Spacing (рисунок 1.8) вводится требуемый размер конечного 

элемента (например, 0,75мм). 

− Для построения конечно-элементной сетки с выбранными 

параметрами нужно нажать кнопку «Apply».  

Результаты построения неупорядоченных треугольной и четырехугольной 

сеток приведены на рис. 2.16 и 2.17.  

 
Рисунок 1.8 - Меню разбиения поверхности 

 
На этом построение расчетной модели с неструктурированной конечно-

элементной сеткой закончено. Для дальнейшего проведения расчета, 

 



исследования структуры и параметров потока ее нужно передать в 

программу Fluent.  

1.6 Передача построенной расчетной модели во Fluent и закрытие 
программы 

Для экспорта созданной модели в верхнем меню нужно выбрать 

следующие пункты:  

ВМ: File → Export → Mash. 
В появившемся окне нужно ввести имя файла обмена. По умолчанию 

оно совпадает с именем файла модели (например, BERNOULLI.msh). С 

помощью кнопки Browse можно выбрать место, где файл необходимо 

сохранить. Поскольку расчетная модель двухмерная, то обязательно следует 

нажать кнопку Export 2D (X-Y) Mash. Запись файла обмена подтверждается 

нажатием кнопки Accept. 

Если файл обмена был успешно записан, то в окне сообщений появится 

надпись mash was successfully written to <имя файла>.msh. 

В указанном месте появится файл <имя файла>.msh.  

Сохранение модели Gambit для редактирования или каких-то других 

действий производится с помощью команды:  

ВМ: File → Save. 

Закрытие программы Gambit осуществляется командой: 

ВМ: File → Exit.  

Перед закрытием программы появится окно, предлагающее сохранить 

модель. Для того, чтобы это сделать, нужно нажать Yes. В противном случае 

нужно нажать No. 

2 ЗАПУСК ПРОГРАММЫ FLUENT И ЕЕ ОСОБЕННОСТИ 

Дальнейшие действия с расчетной моделью: задание граничных 

условий, настройка параметров решателя, решение и обработка результатов 

производится в программе Fluent. 
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2.1 Запуск программы Fluent.  

Запуск программы осуществляется нажатием на соответствующий 

ярлык на рабочем столе или из меню «Пуск» ОС «Windows»: 

Пуск → Все программы → ANSYS 14.5 → Fluid Dynamics → FLUENT 

Перед открытием рабочего окна программы появится меню (рисунок 

2.1), предлагающее выбрать тип решаемой задачи: 2d (двухмерная) или 3d 

(трехмерная). Так же для уменьшения времени расчета рекомендуется 

использовать параллельный режим работы программы, для этого выбрать 

опцию Parallel (Local Machine) и ввести количество ядер процессора.  

 
Рисунок 2.1 - – Стартовое окно программы Ansys Fluent 

 
После выбора нужно нажать кнопку Ok. Это действие вызовет 

появление рабочего окна программы Fluent (рисунок 2.2). 

 



 
Рисунок 2.2 - Рабочее окно программы Fluent 

 

2.2 Загрузка расчетной модели, созданной в программе Gambit 

Чтобы прочитать созданную расчетную модель, необходимо в главном 

меню выбрать: 

ГМ: File → Read → Mesh. 

В появившемся стандартном окне проводника ОС «Windows» нужно 

найти место, где был сохранен файл обмена, выбрать его и подтвердить 

выбор кнопкой OK.  

При чтении файла в окне сообщений Fluent появятся полные сведения о 

модели, содержащейся в читаемом файле: размеры, количество и тип 

конечных элементов и т.п. 

2.3 Проверка конечно-элементной сетки на наличие ошибок 

Проверка расчетной сетки на наличие ошибок осуществляется с 

помощью команды: 

ГМ: Mesh → Check. 
После ее запуска программа начнет проверять конечно-элементную сетку, 

а в окне сообщения появятся полные сведения о конечно-элементной сетке. 

Если будет найдена ошибка, то будет выдано соответствующее сообщение. В 
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этом случае необходимо вернуться в программу Gambit, найти ошибку и 

исправить ее.  

2.4 Масштабирование конечно-элементной сетки 

Размеры расчетных моделей в программе Fluent должны быть 

обязательно заданы в метрах. Построение же моделей удобнее проводить в 

миллиметрах. Так, рассматриваемая модель межлопаточного канала была 

создана в миллиметрах. Поэтому построенную сетку нужно уменьшить в 

1000 раз. Для этого в программе есть удобная команда масштабирования 

Scale Mesh (рисунок 2.3). Она вызывается из главного меню командой: 

ГМ: Mesh → Scale. 

В поле Domain Extents меню приведены максимальные координаты 

модели. 

 
Рисунок 2.3 - Меню Scale Mesh 

 
В меню Scaling в поле Mesh Was Created In (сетка была создана в ..) 

нужно выбрать миллиметры mm (или другую единицу измерения, в которой 

была создана расчетная модель), а затем нажать кнопку Scale. Модель будет 

автоматически смасштабирована. Следует обратить внимание на то, что в 

поле Domain Extents размеры модели примут правильные значения. Отменить 

масштабирование в случае ошибки можно с помощью кнопки Unscale. 

После завершения операции меню необходимо закрыть с помощью 

кнопки Close.  

 

 



2.5 Просмотр конечно-элементной сетки. 

Просмотреть конечно-элементную сетку загруженной модели можно с 

помощью команды: 

 ГМ: Display → Mesh 

В появившемся меню Mesh Display (рисунок 2.4) в окне Surfaces 

требуется выбрать все граничные поверхности, которые пользователь хочет 

просмотреть. Следует обратить внимание на то, что имена в списке 

совпадают с именами граничных условий, заданных в Gambit. Для просмотра 

выбранных элементов сетки нужно нажать кнопку Display.  

В результате выполнения команды в графическом окне будет 

отображена расчетная сетка или выбранные элементы модели (рисунок 2.4). 

 
Рисунок 2.4 - Результат отображения расчетной сетки 

 
Для того, чтобы изучить конечно-элементную сетку внимательнее, 

нужно использовать мышь. Движение мыши с нажатой левой кнопкой 

вызывает сдвиг модели. Движение мыши с нажатой средней кнопкой 

вызывает появление рамки, с помощью которой можно приблизить (если 

рамку вытягивать слева направо) выделенный фрагмент модели или, 

наоборот, отдалить (если рамку вытягивать справа налево). 
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Если в окне Surfaces снять выделение с пункта default – interior, то в 

окне можно будет увидеть только контур модели, без расчетной сетки. 

2.6 Задание опций решателя 

В качестве первого действия при описании расчетной модели следует 

выбрать решатель, с помощью которого будет проводиться решение, а также 

определить стационарность или нестационарность задачи. Этот выбор 

осуществляется с помощью команды General:  

ГМ: Define → General. 

В меню General (рисунок 2.5) нужно обратить внимание на следующие 

пункты. 

В поле Solver следует выбрать алгоритм решения. Программа Fluent 

позволяет использовать два алгоритма: Pressure Based (в российской 

литературе его называют алгоритмом установления) или Density Based (в 

российской литературе - алгоритм расщепления). Первый из них изначально 

разрабатывался для низкоскоростных потоков, но впоследствии был мо-

дифицирован и распространен и на другие течения. Алгоритм установления 

создавался для расчетов высокоскоростных транс- и сверхзвуковых потоков. 

Для решения рассматриваемой задачи целесообразно выбрать Pressure Based.  

 
Рисунок 2.5 - Меню General 

 
В поле Time описывается, будет ли решение стационарным Steady или 

нестационарным Transient. То есть, будут ли параметры потока зависеть от 

времени или нет. 

Рассматриваемая задача является стационарной (Steady).  
 



2.7 Учет в расчете уравнения энергии 

При решении задач гидрогазодинамики нужно обязательно учитывать 

изменение температуры потока и тепловые явления (теплообмен и теплопе-

редачу). Для этого необходимо подключить к решению уравнение энергии с 

помощью команды:  

ГМ: Define → Models→ Energy. 

В появившемся окне нужно поставит галочку в строке Energy Equation и 

нажать ОК (рисунок 2.6). 

 
Рисунок 2.6 – Меню включения уравнения энергии (Energy) 

 

2.8 Определение модели течения 

От точности и надежности описания турбулентных явлений 

непосредственно зависит точность и надежность определения отрыва 

пограничного слоя, ламинарно-турбулентного перехода, потерь 

кинетической энергии в потоке, процессов теплообмена и т.д. На настоящий 

период времени нет универсальной модели, корректно описывающей 

турбулентность в любых условиях. Каждая из множества известных моделей 

имеет свою, достаточно узкую, область применения. В программе Fluent 

разработчики предлагают использовать одну из наиболее известных моделей 

турбулентности, таких как: Спаларта-Алламарса, k-ε (k-epsilon), k-ω, модель 

напряжений Рейнольдса.  

Для задания модели турбулентности необходимо выбрать команду: 

ГМ: Define → Models→ Viscous. 

В появившемся списке моделей турбулентности нужно выбрать модель 

турбулентности k-ε (k-epsilon). В появившемся меню отмечается модель RNG 
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и ставится галочка в графе Viscous Heating, что позволит учитывать тепло, 

выделяющееся от вязкого трения слоев газа (рисунок 2.7). 

 
Рисунок 2.7 – Меню выбора модели течения (Viscous Model) 

 

2.9  Задание свойств рабочего тела. 

Задание свойств рабочего тела осуществляется в меню Materials 

(рисунок 2.8), которое вызывается командой: 

ГМ: Define → Materials 

 
Рисунок 2.8 - Меню Materials 

 

 



Так как по умолчанию в программе задан только воздух, надо добавить 

новый материал. Для этого необходимо в меню Create/Edit Materials выбрать 

вкладку Fluent Database…. В появившемся меню Fluent Database Materials во 

вкладке Fluent Fluid Materials необходимо выбрать water-liquid(h2o<l>), 

нажать Copy и Close.  

 
Рисунок 2.9 - Меню Fluent Database Materials 

 

2.10 Задание справочного давления. 

Особенность программы Fluent состоит в том, что давление, получаемое 

и задаваемое в расчете, является избыточным. То есть для того, чтобы 

получить истинное значение давления необходимо прибавить к нему так 

называемое «справочное давление». По умолчанию в его качестве 

используется атмосферное давление в САУ – 101325Па. Если в качестве 

«справочного давления» принять 0, то результаты расчета и исходные 

данные будут задаваться в абсолютных значениях. Изменить значение 

«справочного давления» можно в меню, которое появится в результате 

выполнения команды: 

ГМ: Define → Operating Condition. 

Для упрощения обработки результатов в решаемой задаче целесообразно 

принять «справочное давление», равное нулю, и ввести его значение в поле 

Operating pressure. 
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2.11 Задание граничных условий 

Меню задания граничных условий (рисунок 2.10) вызывается командой: 

ГМ: Define → Boundary Condition. 

В поле Zone находится список всех граничных условий, определенных в 

Gambit. Если выбрать имя одного из них, например pressure_inlet.1, то в окне 

Type будет указан тип граничного условия. В случае необходимости можно 

поменять тип граничных условий во вкладке Type. 

 
Рисунок 2.10 - Меню задания граничного условия 

 
Чтобы приступить к заданию граничных условий, необходимо в окне Zone 

выбрать нужное граничное условие, убедиться, что в окне Type тип 

граничного условия указан верно, и нажать Edit...  

Как отмечалось выше, в рассматриваемой задаче будут заданы следующие 

условия: 

− на выходной границе задается статическое давление р1, равное 

р1=11645Па; 

− на входной границе задается полное давление р0
* и температура Т0

* 

потока, полное давление на входе в канал равно р0
*=11695 Па. 

Температура на входной и выходной границе принимается равной 

Т0
*=293К; 

 



Меню задания граничного условия «полное давление на входе» (pressure-

inlet) показано на рис. 2.28.  

 
Рисунок 2.11 - Меню Pressure inlet 

 

Входное граничное условие задается в следующей последовательности. 

В поле Gauge Total Pressure вводится значение полного давления на 

входе в расчетную область. Необходимо помнить, что в программе Fluent 

задается избыточное относительно заданного в пункте 2.10. Если справочное 

давление равно нулю, как в рассматриваемом примере, то вводится 

абсолютное значение давления. Если справочное давление отличается от 

нулевого, то вводится значение р0изб
*= р0

*-рсп, где  

р0изб
* - значение давления, которое необходимо задать в поле Gauge Total 

Pressure; 

р0
* - абсолютное значение давления; 

рсп – справочное давление. 

В рассматриваемой задаче нужно задать р0изб
*= р0

*=11695 Па. 

В поле Supersonic Gauge Pressure задается статическое давление потока 

для случая сверхзвукового течения на входе. Скорость потока на входе в 

трубу мала, поэтому в данном поле можно поставить нулевое значение. 

Однако для стабильности решения в этом поле целесообразно вводить зна-

чение, близкое либо равное статическому давлению. р0=11695 Па. 
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В нашем случае, когда входящий поток направлен нормально к входной 

границе, в поле Direction Specification Method выбирается пункт Normal to 

Boundary (перпендикулярно границе). 

Для решения задачи течения газа с помощью двухпараметрической 

модели турбулентности типа k-ε или k-ω необходимо определить 

дополнительные граничные условия. Тип граничных условий для 

турбулентности задается в поле Speciation Method. 

Наиболее простым типом граничных условий турбулентности является 

задание масштаба турбулентности и гидравлического диаметра – Intensity and 

Hydraulic Diameter. В этом случае в поле Turbulent Intensity задается 

интенсивность турбулентности из диапазона 1……...10%. В поле Hydraulic 

Diameter вводится гидравлический диаметр. Он находится по формуле 

П
Fdг

4
= ,  

где П – периметр сечения; 

F – его площадь.  

Для случая двухмерного течения в трубе гидравлический диаметр равен 

диаметру входного отверстия. В рассматриваемом примере D=0.014м. 

Для задания полной температуры потока на входе нужно в верхней 

части меню нажать на закладку Thermal, а в ставшем доступном поле Total 

Temperature ввести значение температуры. Для рассматриваемого примера 

Т0
*=293К. 

Для задания граничного условия на выходной границе в меню Boundary 

Condition нужно выбрать имя данной границы и нажать кнопку Set. Это 

вызовет появление меню Pressure Outlet (рисунок 2.12). 

Для задания выходного граничного условия в этом меню необходимо в 

поле Gauge Pressure установить статическое давление на выходе из 

расчетной области (в случае, если справочное давление не равно нулю, то 

задается избыточное давление). В рассматриваемом примере р1=11645Па. 

Для задания полной температуры потока на выходе нужно в верхней части 

меню нажать на закладку Thermal, а в ставшем доступном поле Total 
 



Temperature ввести значение температуры. Для рассматриваемого примера 

Т0
*=293К. 

 
Рисунок 2.12 - Меню Pressure Outlet 

 
Кроме перечисленных выше граничных условий в решаемой задаче 

присутствует граничное условие стенки (wall). По умолчанию в программе 

Fluent стенка считается адиабатной, что и требуется в решаемой задаче. 

Поэтому граничное условие Wall настраивать также не нужно. 

На этом процесс задания граничных условий закончен и необходимо 

закрыть окно Boundary Condition. 

2.12 Установка параметров счета 

Доступ к меню установки параметров счета осуществляется с помощью 

команды: 

ГМ: Solve → Controls. 

В результате появится меню Solution Controls (рисунок 2.13). 
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Рисунок 2.13 - Меню Solution Controls 

 

В зоне Under-Relaxation Factors задаются коэффициенты релаксации при 

решении соответствующих уравнений. Уменьшение коэффициентов 

улучшает сходимость решения, но заметно увеличивают время счета. 

Снижение коэффициента релаксации широко применяется при проблемах с 

запуском расчета задачи, но их выбор требует определенного опыта. Поэтому 

по возможности их следует оставлять неизменными.  

 

2.13 Установка начальных значений параметров 

При решении задач гидрогазодинамики численными методами перед 

запуском решения необходимо установить начальные значения параметров в 

расчетной области. Правильный выбор этих параметров может существенно 

улучшить устойчивость и сходимость, чем ускорить получение решения. 

Меню установки начальных условий (рисунок 2.14) вызывается командой:  

ГМ: Solve → Initialization… 

В этом меню в поле Compute From необходимо выбрать входную 

границу. В результате рекомендуемые значения начальных параметров будут 

рассчитаны по входным граничным условиям.  

Для их принятия следует нажать Initialize. 
 



 
Рисунок 2.14 - Меню установки начальных значений параметров 

 

2.14 Сохранение расчетной модели и запуск решения 

Для сохранения расчетной модели и всех сделанных настроек решателя 

необходимо вызвать команду: 

ГМ: File → Write → Case. 

В появившемся окне проводника необходимо выбрать место, где будет 

сохранена модель и ее имя. После нажатия кнопки ОК в указанном месте 

появится файл модели с расширением *.сas.  

Для запуска решения нужно выбрать команду: 

ГМ: Solve → Run Calculation 

Для запуска решения в поле Number of Iteration нужно ввести число 

итераций (например, 1000) и нажать кнопку Calculate. Число итераций 

можно назначить произвольно. Оно, как правило, исчисляется сотнями.  

Если условие сходимости будет достигнуто, то процесс счета 

остановится сам. Если заданного числа итераций будет недостаточно для 

получения решения, то процесс решения можно продолжить.  
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Решение может быть остановлено в любой момент нажатием на кнопку 

Cancel и вновь запущено с места остановки нажатием кнопки Calculate в 

меню запуска решения. В ходе паузы могут быть просмотрены 

предварительные результаты решения, внесены изменения в граничные 

условия или настройки решателя.  

После запуска решения в графическом окне появится зависимость 

невязок от номера итерации для каждого уравнения (рисунок 2.15). Обратите 

внимание, что для каждого уравнения значения невязок различны.  

Как видно из рисунка 2.15 для задачи примерно на девятьсот тридцатой 

итерации значения невязок по каждому из уравнений достигли заданных 

величин. В этом случае программа Fluent остановит решение и в окне 

сообщений выдаст сообщение solution is converged.  

 
Рисунок 2.15 - Изменение невязок по итерациям 

 

2.15 Визуализация полей распределения параметров в расчетной 
области. 

Для просмотра полей распределения параметров необходимо запустить 

команду: 

ГМ: Display → Graphics and Animations → Contours. 

В результате ее выполнения появится меню Contours (рис. 2.38). 

Чтобы распределение параметров отображалось в виде полей, 

необходимо в окошке Filled поставить галочку. В противном случае 

распределения параметров будут изображаться в виде изолиний. 

 



Параметр, изменение которого требуется отобразить, выбирается в поле 

Contours of. Оно состоит из двух выпадающих списков (рисунок 2.16). В 

верхнем из них выбирается группа, к которой принадлежит нужный параметр 

(например, давление). В нижнем списке уточняется, какой именно параметр 

группы требуется определить (например, полная скорость). Это типовая и 

часто используемая процедура выбора отображаемого параметра в 

программе Fluent. Аналогичным образом, определяется параметр при 

определении среднеинтегральных значений. 

 
Рисунок 2.16 - Меню Contours 

 

В поле Surfaces задаются поверхности, на которых строятся поля 

распределений параметров. В данном случае рассматривается двухмерная 

постановка задачи и если в этом окне ни выбирать поверхности, то будет 

построено по всей расчетной области.  

Для иллюстрации ниже приведены полученные в расчете распределения 

полного и статического давления на рисунках 2.17 и 2.18 соответственно. 

Обратите внимание на то, что если справочное давление в меню Operation 

Condition задано не равным нулю, то давление является избыточным 

относительно справочного (в рассматриваемом примере давление 

абсолютное). 
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Рисунок 2.17 - Поле статических давлений в канале 

 

 
Рисунок 2.18 - Поле полных давлений в канале 

 

 

 



Шаг 28. Создание изоповерхностей. 

Несмотря на большое число способов построения поверхностей, на ко-

торых требуется отобразить поля распределения параметров, наиболее часто 

применяется построение изоповерхностей. Под ними понимается 

поверхность произвольной формы, на которой значение произвольно вы-

бранного параметра равно конкретной величине. Например, при отобра-

жении результатов часто приходится пользоваться поверхностями с по-

стоянными координатами x, y, z, a, ϕ или r. В экологических исследованиях 

можно визуализировать поверхность с предельным значением концентрации 

какого-то опасного вещества. 

 

Создаем изоповерхности, в которых в последствии будем строить графики 

изменения параметров (рис.2.45.) 

 
Рис. 2.45. Меню ISo-Surface 

 

Задаем значение 0.1 в поле Iso-Values и указываем имя поверхности 

x=0.1, таким же образом создаем поверхности на расстояниях 0.5 и  0.85 

для X-coordinate и 0.005,  0.007 для Y-coordinate 

 

Шаг 29. Построение графиков изменения параметров. 
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Программа Fluent позволяет строить графики распределения любого 

рассчитанного параметра вдоль произвольной поверхности или линии. Меню 

построения графиков (рис. 2.46) вызывается командой 

ГМ: Plot → XY-plot. 

 
Рис. 2.46. Меню XY-plot 

 

В меню XY-plot необходимо убрать галочку в окошке Position on X Axis. В 

результате станут доступны поля Y Axis Function и X Axis Function – 

параметры по оси у и х соответственно. Чтобы построить, например, 

изменение полного давления в нужном сечении, необходимо в качестве 

параметра на оси у выбрать полное давление (Pressure → Total Pressure), а в 

качестве параметра по оси х – координату х (Grid → Y-Coordinate). В поле 

Surfaces задается поверхность или линия, на которой строится распределение 

(в рассматриваемом примере – изоповерхности). Для построения графика по 

сделанным настройкам нужно нажать кнопку Plot. Результат действия 

показан на рис. 2.47. Зависимости изменения других параметров строятся 

аналогично.  

 



 
Рис. 2.47. Зависимость изменения полного давления по оси Y 

 

 
Рис. 2.48. Зависимость изменения полного давления по оси X 
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Рис. 2.49. Зависимость изменения скорости потока по оси Y 

 

 
Рис. 2.50. Зависимость изменения скорости потока по оси X 

 
 



Рис. 2.51. Зависимость изменения абсолютной температуры потока по 

оси Y 

 

 
Рис. 2.52. Зависимость изменения абсолютной температуры потока по 

оси X 

 

 

 
Рис. 2.53. Зависимость изменения критерия Ренольца по оси X 
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Если в окошке Write to file поставить галочку, то полученный график 

может быть записан в текстовый файл, который в дальнейшем может быть 

использован как в программе Fluent, так и в других программах, например 

Excel. 

 

Шаг 30. Построение линий тока. 

Для отображения линий тока используется команду ГМ: Display → 

Pathlines. Ее меню показано на рис. 2.54.  

 
Рис. 2.54. Меню отображения линий тока  

 

Основные настройки состоят в следующем. 

В поле Release from Surface выбирается граничная или вспомогательная 

поверхность, линия или точка, из которой выходят интересующие 

пользователя линии тока. 

В поле Color by задается закономерность окраски линии тока. Цвет линий 

в каждой точке расчетной области будет соответствовать величине 

параметра, определенного в зоне Color by. 

В поле Style выбирается вид линий тока. Они могут быть изображены в 

виде линий (line), стрелок (line-arrows), точек (point), сфер (sphere), лент 

(ribbon), треугольников (triangle) и др. Настроить вид линий тока (длину 

линий, размер сфер, длину стрелок и т.п.) можно в меню, доступ к которому 

осуществляется нажатием кнопки Style Attributes. 

 



В поле Step Size вводится размер шага, а в поле Steps - число шагов. В 

случае, если линии тока расположены слишком густо и мешают анализу 

картины течения, их можно проредить, задав в поле Path Skip число про-

пусков.  

Построение линий тока по сделанным настройкам осуществляется на-

жатием кнопки Display. Для наглядности течение можно посмотреть в 

анимированном виде. Для этого нужно нажать кнопку Pulse. Отображение 

анимированных линий тока может быть осуществлено в двух вариантах:  

− непрерывное движение частиц рабочего тела (continuous); 

− показывается движение небольшой дозы рабочего тела, вошедшего 

через указанную поверхность (single).  

Выбор режима отображения анимированных линий тока осуществляется в 

поле Pulse Mode. 
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